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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product Features

Standard Configuration Features
The HP Compaq Small Form Factor features may vary depending on the model. For a complete
listing of the hardware and software installed in the computer, run the diagnostic utility (included on
some computer models only).

NOTE: The Small Form Factor computer can also be used in a tower orientation. For more
information, see Using the Small Form Factor Computer in a Tower Orientation on page 85 in this
guide.

Figure 1-1  Small Form Factor Configuration
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Front Panel Components
Drive configuration may vary by model. Some models have a bezel blank covering one or more drive
bays.

Figure 1-2  Front Panel Components

Table 1-1  Front Panel Components

1 5.25-inch Optical Drive 6 USB (Universal Serial Bus) Ports

2 Optical Drive Activity Light 7 Microphone Connector

3 Optical Drive Eject Button 8 3.5-inch Media Card Reader (optional)

4 Dual-State Power Button 9 Hard Drive Activity Light

5 Power On Light 10 Headphone Connector

NOTE: The Power On Light is normally green when the power is on. If it is flashing red, there is a problem with
the computer and it is displaying a diagnostic code.
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Rear Panel Components
Figure 1-3  Rear Panel Components

Table 1-2  Rear Panel Components

1 RJ-45 Network Connector 6 DVI-D Connector

2 VGA Monitor Connector 7 PS/2 Mouse Connector (green)

3 Serial Connector 8 PS/2 Keyboard Connector (purple)

4 Power Cord Connector 9 Line-Out Connector for powered audio
devices (green)

5 Universal Serial Bus (USB) 10 Line-In Audio Connector (blue)

NOTE: An optional second serial port and an optional parallel port are available from HP.

The monitor connectors on the system board are inactive when a graphics card is installed in the computer.

If a graphics card is installed into one of the system board slots, the connectors on the graphics card and the
system board may be used at the same time. Some settings may need to be changed in Computer Setup to use
both connectors.
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Serial Number Location
Each computer has a unique serial number and product ID number in the location shown below. Keep
these numbers available for use when contacting customer service for assistance.

Figure 1-4  Serial Number and Product ID Location
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2 Installing and Customizing the
Software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

NOTE: If the computer was shipped with Windows Vista or Windows 7 loaded, you will be prompted
to register the computer with HP Total Care before installing the operating system. You will see a
brief movie followed by an online registration form. Fill out the form, click the Begin button, and follow
the instructions on the screen.

CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the Windows Operating System
The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Downloading Microsoft Windows Updates
1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on

the screen.

2. Once an Internet connection has been established, click the Start button.
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3. Select the All Programs menu.

4. Click on the Windows Update link.

In Windows Vista and Windows 7, the Windows Update screen appears. Click view available
updates and make sure all critical updates are selected. Click the Install button and follow the
instructions on the screen.

In Windows XP, you will be directed to the Microsoft Windows Update Web site. If you see
one or more pop-up windows that ask you to install a program from http://www.microsoft.com,
click Yes to install the program. Follow the instructions on the Microsoft Web site to scan for
updates and install critical updates and service packs.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or Upgrading Device Drivers (Windows
systems)

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\i386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the Monitor Display (Windows systems)
If you wish, you can select or change the monitor model, refresh rates, screen resolution, color
settings, font sizes, and power management settings. To do so, right-click on the Windows Desktop,
then click Personalize in Windows Vista and Windows 7 or Properties in Windows XP to change
display settings. For more information, refer to the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Launching Windows XP from Windows 7
Windows XP Mode for Windows 7 allows you to install and launch Windows XP applications from the
Windows 7 taskbar. This feature is available on some computer models only.

To set up from a pre-installed Windows 7 desktop, click Start > Windows Virtual PC > Virtual
Windows XP and follow the instructions on the screen.
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Accessing Disk Image (ISO) Files
There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be
created and the software installed in order to get the most from your PC. The software and image file
names are:

● Corel WinDVD SD and BD – installation software for WinDVD – used to play DVD movies

● HP Insight Diagnostics OR Vision Diagnostics – software to perform diagnostic activities on your
PC

Accessing Disk Image (ISO) Files 7



3 Computer Setup (F10) Utility

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash
media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

● Secure integrated I/O functionality, including USB, audio, or embedded NIC, so that they cannot
be used until they are unsecured.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Replicate the system setup by saving system configuration information on a USB flash drive and
restoring it on one or more computers.

● Execute self-tests on a specified ATA hard drive (when supported by drive).
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom
of the screen.

NOTE: If you do not press Esc at the appropriate time, you must restart the computer and
again press Esc when the monitor light turns green to access the utility.

3. Press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

6. To apply and save changes, select File  > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings, select Apply Defaults and Exit. This option will restore the
original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-1  Computer Setup—File

Option Description

System Information Lists:

● Product name

● SKU number (some models)

● Processor type/speed/stepping

● Cache size (L1/L2/L3)

● Installed memory size/speed, number of channels (single or dual) (if applicable)

● Integrated MAC address for embedded, enabled NIC (if applicable)

● System BIOS (includes family name and version)

● Chassis serial number

● Asset tag

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-2  Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware, and serial number.

USB: Model and size.

CD-ROM: Model, firmware, and serial number.

Diskette: Model. Only displays when a USB diskette drive is connected to the computer.

Storage Options SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. There are two supported options: AHCI and IDE.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

IDE - This is the most backwards-compatible setting of the two options. Operating systems usually
do not require additional driver support in IDE mode.

NOTE: The AHCI device driver must be installed prior to attempting to boot from an AHCI
volume. If you attempt to boot from an AHCI volume without the required device driver installed,
the system will crash (blue screen).

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which UEFI boot sources and legacy boot sources (such as a USB flash
media device, hard drive, optical drive, or network interface card) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or
included for consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

Press F5 to disable a device. Press Enter to select a device. Press the arrow keys to drag a
selected device.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 before the computer boots to the operating system. After POST is
completed, a list of bootable devices is displayed. Use the arrow keys to select the preferred
bootable device and press Enter. The computer then boots from the selected non-default device
for this one time.

Computer Setup (F10) Utilities 11



Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-3  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle or reboot. If the user does not enter the correct power-on password, the unit
will not boot.

Device Security Allows you to set Device Available/Device Hidden for:

● System Audio

● Network Controller (some models)

● SATA0

● SATA1

USB Security Allows you to enable or disable groups of USB ports or individual USB ports. Default is device
available.

● Front USB Ports

◦ USB Port 0

◦ USB Port 1

◦ USB Port 4

◦ USB Port 5

● Rear USB Ports

◦ USB Port 8

◦ USB Port 9

◦ USB Port 10

◦ USB Port 11

● internal USB Ports

◦ USB Port 2

◦ USB Port 3

Slot Security Allows you to disable or enable the PCI or PCI Express slot. Default is enable.

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
Express expansion card or embedded on the system board.) Default is enable.
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Table 3-3  Computer Setup—Security (continued)

System IDs Displays the following:

● Product name

● Serial number

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are
used to uniquely identify the system.)

● SKU number

● Family name

● Asset tag (18-byte identifier). A property identification number assigned by the company to
the computer.

● Feature byte

● Build ID

● Keyboard locale setting (for example, English or German)

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
security breaches. Default is enabled.

Virtualization Technology (VTx/VTd) (some models) (enable/disable) - Controls the virtualization
features of the processor and virtualization DMA remapping features of the chipset. Changing this
setting requires turning the computer off and then back on. Default is disabled.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-4  Computer Setup—Power

Option Description

Hardware Power
Management

● SATA Power Management—Enables or disables the SATA bus and/or device power
management. Default is enabled.

● S4/S5 Wake On LAN—Wake on LAN (WOL) is normally used to turn on and shutdown
systems remotely. This option wakes the system from S4 (hibernate)/S5 (off) power state
when a Wake on LAN packet is received and follows normal boot order. Default is disabled.

Thermal Displays the system fan speed (RPMs).
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Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 3-5  Computer Setup—Advanced

Option Heading

Power-On Options Allows you to set:

● POST messages (enable/disable). Suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected.

● After Power Loss (off/on/previous state): Setting this option to:

◦ Off—causes the computer to remain powered off when power is restored.

◦ On—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (None, 5, 10 15, 20, or 60 seconds). Enabling this feature will add a user-
specified delay to the POST process. This delay is sometimes needed for hard disks on
some PCI cards that spin up very slowly, so slowly that they are not ready to boot by the time
POST is finished. The POST delay also gives you more time to select F10 to enter Computer
(F10) Setup.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.
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Table 3-5  Computer Setup—Advanced (continued)

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enable.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disable.

Device Options Allows you to set:

● Num Lock State at Power-On (off/on). Default is on.

● Parallel Port Mode (EPP+ECP, Output-only, Bi-directional).

● Multi-Processor (enable/disable). Use this option to disable multi-processor support under
the OS. Default is enabled.

● Hyper-threading (Enable/disable). Provides processor parallelization such that the operating
system treats one processor as two. Default is enable.

● NIC Option ROM Download (enable/disable). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1 MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. Default is-enable.

● Processor Frequency Multiplier. Accessible using CTRL+A. The frequency multiplier adapts
the external frequency of the computer to the internal frequency of the processor. This
setting lets you overclock your computer.
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4 Serial ATA (SATA) Drive Guidelines
and Features

NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics  

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)

Data interface voltage differential 400-700 mV

Drive voltages 3.3 V, 5 V, 12 V

Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities
The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

 Maximum Size

File System Controller Type Operating System Partition Drive

FAT 32 ATA Windows XP/Windows Vista/Windows 7 32 GB 2 TB

NTFS ATA Windows XP/Windows Vista/Windows 7 2 TB 2 TB
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5 Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage. 

Chassis Designations

Small Form Factor (SFF)

Figure 5-1  Small Form Factor chassis

Chassis Designations 19



Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

● Different activities generate different amounts of static electricity.

● Static electricity increases as humidity decreases.

 Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

Removing DIPs from plastic tube

7,500 V

3,000 V

400 V

400 V

15,000 V

5,000 V

800 V

700 V

35,000 V

12,000 V

6,000 V

2,000 V

Removing DIPs from vinyl tray

Removing DIPs from Styrofoam

Removing bubble pack from PCB

Packing PCBs in foam-lined box

2,000 V

3,500 V

7,000 V

5,000 V

4,000 V

5,000 V

20,000 V

11,000 V

11,500 V

14,500 V

26,500 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

● To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

● Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

● Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their container.
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● Always be properly grounded when touching a sensitive component or assembly.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

● Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage

Antistatic plastic

Carbon-loaded plastic

Metallized laminate

1,500

7,500

15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment.

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

● Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors
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● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels

● Wrist straps and footwear straps providing one-megohm +/- 10% resistance

● Material handling packages

● Conductive plastic bags

● Conductive plastic tubes

● Conductive tote boxes

● Opaque shielding bags

● Transparent metallized shielding bags

● Transparent shielding tubes

Operating Guidelines
To prevent overheating and to help prolong the life of the computer:

● Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

● Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

● Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

● Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

● Never operate the computer with the cover or side panel removed.

● Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

● If the computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still
apply.

● Keep liquids away from the computer and keyboard.
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● Never cover the ventilation slots on the monitor with any type of material.

● Install or enable power management functions of the operating system or other software,
including sleep states.

Routine Care

General Cleaning Safety Precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.

4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 23 before cleaning the
computer.

To clean the computer case, follow the procedures described below:

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.

Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 23 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 23.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 23 before following these procedures:
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CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys. 

● Visible debris underneath or between the keys may be removed by vacuuming or shaking.

● Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

● Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

● Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

● To clean the monitor body follow the procedures in Cleaning the Computer Case on page 23.

Cleaning the Mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

● Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

● To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 23.

Service Considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes. 

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.
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Tools and Software Requirements

To service the computer, you need the following:

● Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

● Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

● Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

● Phillips #2 screwdriver

● Diagnostics software

● HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer. 

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

Service Considerations 25



● Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 20

● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.

26 Chapter 5   Identifying the Chassis, Routine Care, and Disassembly Preparation



6 Illustrated parts catalog

This chapter provides parts information for the chassis.

Spare parts

Computer major components
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Item Description Spare part number

(1) Access panel 636924-001

(2) Front bezel 636920-001

(3) Power supply  

 240W, 85% efficiency 613663-001

 240W, high voltage protection 613664-001

 240W 613763-001

(4) Speaker, internal 636925-001

(5) System board (includes replacement thermal material) 676358-001

(6) Chassis fan 636922-001

(7) Baffle 636921-001

(8) Heat sink (includes replacement thermal material) 636919-001

(9) Front I/O and power switch assembly 636926-001

 Cables  

(10) SATA power cable 636923-001

(11) SATA cable, 1 straight end, 1 angled end (25 inch; 365 mm) 638814-001

(12) SATA cable, 2 straight ends 19-inch; 483 mm) 638813-001

 SATA USB 3.0 SuperSpeed power extension cable, 20 in 663214-001

 SATA power extension cable, 20 in 633756-001

 HP DisplayPort cable 487562-001

 Adapter, DMS-59 to dual VGA 463023-001

 Adapter, DisplayPort (DP) to DVI 662723-001

 Adapter, DVI to VGA 657401-001

 Adapter, DisplayPort (DP) to HDMI 617450-001

 Adapter, DisplayPort (DP) to VGA 603250-001

 Memory modules (PC3-12800, 1666-MHz)  

 8-MB 689375-001

 4-GB 671613-001

 2-GB 671612-001

 Hard drives

 1-TB 636930-001

 500-GB 636929-001

 250-GB 636927-001

 256-GB Solid-state drive (SSD), SATA 6.0 661842-001

 120-GB Solid-state drive (SSD), SATA 2.0 661841-001
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Item Description Spare part number

 Optical drives  

 6X BD-Writer SuperMulti drive 656792-001

 16X DVD±RW SuperMulti drive 660408-001

 16X DVD-ROM drive 682550-001

 Expansion cards  

 ATI Radeon HD7450, 1-GB PCIe x16 graphics card, includes adapter 682411-001

 ATI Radeon HD6350, 512-MB PCIe x16 graphics card 637995-001

 AMD FirePro 2270 PCIe x16 graphics card, 512-MB 637213-001

 nVidia Quadro NVS310 PCIe x16 graphics card 680653-001

 nVidia Quadro NVS300 PCIe x16 graphics card 632486-001

 HP FireWire / IEEE 1394a PCIe x1 Card 637591-001

 USB 3.0 SuperSpeed PCI-3 x1 card, includes 2 external Type A ports and 2 internal
ports

663213-001

 USB 3.0 SuperSpeed PCI-3 x1 card, includes 2 external Type A ports 608151-001

 HP WLAN 802.11 g/n 1x2 PCIe NIC 538048-001

 Intel PRO/1000CT2 NIC, includes bracket 635523-001

 Keyboard 

NOTE: For a list of supported countries and associated dash numbers, see Sequential
part number listing on page 30.

 

 HP PS/2 537745-xxx

 HP USB 537746-xxx

 USB SmartCard 631411-xxx

 Wireless 674314-xxx

 Washable 613125-xxx

 Processors (include replacement thermal material)  

 ● Intel Core i7 3770s processor, 3.1 GHz 689370-001

 ● Intel Core i5 3570 processor, 3.4 GHz 688162-001

 ● Intel Core i5 3570s processor, 3.1 GHz 695079-001

 ● Intel Core i5 3475s processor, 2.9 GHz 695078-001

 ● Intel Core i5 3470s processor, 2.9 GHz 695077-001

 ● Intel Core i3 2130 processor, 3.4 GHz 665120-001

 ● Intel Core i3 2120 processor, 3.3 GHz 638629-001

 ● Intel Pentium Dual-Core G870 processor, 3.1 GHz 691936-001

 ● Intel Pentium Dual-Core G860 processor, 3.0 GHz 665123-001

 ● Intel Pentium Dual-Core G640 processor, 2.8 GHz 691935-001

Spare parts 29



Item Description Spare part number

 ● Intel Celeron G550 processor, 2.6 GHz 691934-001

 ● Intel Celeron G540 processor, 2.5 GHz 665119-001

 ● Intel Celeron G460 processor, 1.8 GHz 682410-001

 Mouse  

 Wireless 674317-001

 USB, optical, black 537749-001

 USB, laser, black 570580-001

 Washable 619580-001

 Wireless keyboard/mouse transceiver 674319-001

 Bezel blank, 5.25-inch 570838-001

 Antenna for use with WLAN module 538048-001 583345-001

 Hard drive grommet 450712-001

 Hard drive adapter, 2.5 inch 586721-001

 Printer port kit 638817-001

 Serial port kit 638815-001

 Card reader, 22-in-1 636166-001

 USB speakers, external 636917-001

 USB webcam 674317-001

 Rubber Feet Kit 583654-001

 Chassis stand 688952-001

 HP Business Digital Headset 642738-001

 Hard drive conversion bracket 397117-001

 Screw Kit 393956-001

Sequential part number listing

Spare part
number

Description

393956-001 Screw Kit

397117-001 Hard drive conversion bracket

450712-001 Hard drive grommet

463023-001 Adapter, DMS-59 to dual VGA

487562-001 HP DisplayPort cable

508987-001 Clamp Lock Kit, includes universal cable (plate not included)

537745-001 Keyboard, PS/2, the United States
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Spare part
number

Description

537745-031 Keyboard, PS/2, the United Kingdom

537745-041 Keyboard, PS/2, Germany

537745-051 Keyboard, PS/2, France

537745-061 Keyboard, PS/2, Italy

537745-071 Keyboard, PS/2, Spain

537745-081 Keyboard, PS/2, Denmark

537745-091 Keyboard, PS/2, Norway

537745-101 Keyboard, PS/2, Sweden

537745-111 Keyboard, PS/2, Switzerland

537745-121 Keyboard, PS/2, French Canada

537745-131 Keyboard, PS/2, Portugal

537745-141 Keyboard, PS/2, Turkey

537745-151 Keyboard, PS/2, Greece

537745-161 Keyboard, PS/2, Latin America

537745-171 Keyboard, PS/2, Saudi Arabia

537745-181 Keyboard, PS/2, Belgium

537745-201 Keyboard, PS/2, Brazil

537745-211 Keyboard, PS/2, Hungary

537745-221 Keyboard, PS/2, the Czech Republic

537745-231 Keyboard, PS/2, Slovakia

537745-241 Keyboard, PS/2, Poland

537745-251 Keyboard, PS/2, Russia

537745-261 Keyboard, PS/2, Bulgaria

537745-281 Keyboard, PS/2, Belarus

537745-331 Keyboard, PS/2, the Netherlands

537745-351 Keyboard, PS/2, Finland

537745-541 Keyboard, PS/2, Turkey F

537745-AA1 Keyboard, PS/2, Simplified Chinese

537745-AB1 Keyboard, PS/2, Taiwan

537745-AC1 Keyboard, PS/2, Hong Kong

537745-B31 Keyboard, PS/2, International English

537745-B41 Keyboard, PS/2, BHCSY

537745-BB1 Keyboard, PS/2, Israel

537745-BL1 Keyboard, PS/2, BHCSY
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Spare part
number

Description

537745-CA1 Keyboard, PS/2, Estonia

537745-DD1 Keyboard, PS/2, Iceland

537745-DE1 Keyboard, PS/2, Arab

537745-DF1 Keyboard, PS/2, Kazakstan

537745-KD1 Keyboard, PS/2, South Korea

537745-L31 Keyboard, PS/2, International

537746-001 Keyboard, USB, the United States

537746-031 Keyboard, USB, the United Kingdom

537746-041 Keyboard, USB, Germany

537746-051 Keyboard, USB, France

537746-061 Keyboard, USB, Italy

537746-071 Keyboard, USB, Spain

537746-081 Keyboard, USB, Denmark

537746-091 Keyboard, USB, Norway

537746-101 Keyboard, USB, Sweden

537746-111 Keyboard, USB, Switzerland

537746-121 Keyboard, USB, French Canada

537746-131 Keyboard, USB, Portugal

537746-141 Keyboard, USB, Turkey

537746-151 Keyboard, USB, Greece

537746-161 Keyboard, USB, Latin America

537746-171 Keyboard, USB, Saudi Arabia

537746-181 Keyboard, USB, Belgium

537746-201 Keyboard, USB, Brazil

537746-211 Keyboard, USB, Hungary

537746-221 Keyboard, USB, the Czech Republic

537746-231 Keyboard, USB, Slovakia

537746-241 Keyboard, USB, Poland

537746-251 Keyboard, USB, Russia

537746-281 Keyboard, USB, Belarus

537746-331 Keyboard, USB, the Netherlands

537746-351 Keyboard, USB, Finland

537746-541 Keyboard, USB, Turkey F

537746-AA1 Keyboard, USB, Simplified Chinese
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Spare part
number

Description

537746-AB1 Keyboard, USB, Taiwan

537746-AC2 Keyboard, USB, Hong Kong

537746-B31 Keyboard, USB, International English

537746-BB1 Keyboard, USB, Israel

537746-BL1 Keyboard, USB, BHCSY

537746-CA1 Keyboard, USB, Estonia

537746-DD1 Keyboard, USB, Iceland

537746-DE1 Keyboard, USB, Arab

537745-DF1 Keyboard, USB, Kazakstan

537746-KD1 Keyboard, USB, South Korea

537746-L31 Keyboard, USB, International

537749-001 Mouse, USB, optical, black

538048-001 HP WLAN 802.11 g/n 1x2 PCIe NIC

570580-001 Mouse, USB

570838-001 Bezel blank, 5.25-inch

583654-001 Rubber Feet Kit

603250-001 Adapter, DisplayPort (DP) to VGA

608151-001 USB 3.0 SuperSpeed PCI-3 x1 card, includes 2 external Type A ports

613125-121 Keyboard, washable, French Canada

613125-001 Keyboard, washable, the United States

613663-001 Power supply, 240W, 85% efficiency

613664-001 Power supply, 240W, High Voltage protection

613763-001 Power supply, 240 W

617450-001 Adapter, DisplayPort (DP) to HDMI

619580-001 Mouse, washable

631411-004 Keyboard, SmartCard, the United States

631411-034 Keyboard, SmartCard, the United Kingdom

631411-044 Keyboard, USB, SmartCard, Germany

631411-054 Keyboard, USB, SmartCard, France

631411-064 Keyboard, USB, SmartCard, Italy

631411-074 Keyboard, USB, SmartCard, Spain

631411-084 Keyboard, USB, SmartCard, Denmark

631411-094 Keyboard, USB, SmartCard, Norway

631411-104 Keyboard, USB, SmartCard, Sweden
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Spare part
number

Description

631411-114 Keyboard, USB, SmartCard, Switzerland

631411-124 Keyboard, USB, SmartCard, French Canada

631411-134 Keyboard, USB, SmartCard, Portugal

631411-144 Keyboard, USB, SmartCard, Turkey

631411-154 Keyboard, USB, SmartCard, Greece

631411-164 Keyboard, USB, SmartCard, Latin America

631411-174 Keyboard, USB, SmartCard, Saudi Arabia

631411-184 Keyboard, USB, SmartCard, Belgium

631411-204 Keyboard, USB, SmartCard, Brazil

631411-214 Keyboard, USB, SmartCard, Hungary

631411-224 Keyboard, USB, SmartCard, the Czech Republic

631411-234 Keyboard, USB, SmartCard, Slovakia

631411-244 Keyboard, USB, SmartCard, Poland

631411-254 Keyboard, USB, SmartCard, Russia

631411-264 Keyboard, USB, SmartCard, Bulgaria

631411-274 Keyboard, USB, SmartCard, Romania

631411-284 Keyboard, USB, SmartCard, Thailand

631411-334 Keyboard, USB, SmartCard, the Netherlands

631411-554 Keyboard, USB, SmartCard, Turkey F

631411-AA4 Keyboard, USB, SmartCard, Simplified Chinese

631411-AB4 Keyboard, USB, SmartCard, Taiwan

631411-B44 Keyboard, USB, SmartCard, International English

631411-BB4 Keyboard, USB, SmartCard, Israel

631411-BL4 Keyboard, USB, SmartCard, BHCSY

631411-CA4 Keyboard, USB, SmartCard, Estonia

631411-DD4 Keyboard, USB, SmartCard, Iceland

631411-DE4 Keyboard, USB, SmartCard, Arab

631411-DF4 Keyboard, USB, SmartCard, Kazakstan

631411-KD4 Keyboard, USB, SmartCard, South Korea

631411-L34 Keyboard, USB, SmartCard, International

632486-001 nVidia Quadro NVS300 PCIe x16 graphics card

635523-001 Intel PRO/1000CT2 NIC, includes bracket

636166-001 Card reader, 22-in-1

636917-001 USB speakers, external
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Spare part
number

Description

636919-001 Heat sink (includes replacement thermal material)

636920-001 Front bezel

636921-001 Baffle 

636922-001 Chassis fan

636923-001 SATA power cable

636924-001 Access panel

636925-001 Speaker, internal

636926-001 Front I/O and power switch assembly

636927-001 250-GB hard drive

636929-001 500-GB hard drive

636930-001 1-TB hard drive

637213-001 AMD FirePro 2270 PCIe x16 graphics card, 512-MB

637591-001 HP FireWire / IEEE 1394a PCIe x1 Card

637995-001 ATI HD6350, 512-MB PCIe x16 graphics card

638629-001 Intel Core i3 2120 processor, 3.3 GHz

638813-001 SATA cable, 2 straight ends (19 inch (483 mm)

638814-001 SATA cable, 1 straight end, 1 angled end (25 inch; 635 mm)

638815-001 Serial port

638817-001 Printer port

642738-001 HP Business Digital Headset

656792-001 6X BD-Writer SuperMulti drive

657401-001 Adapter, DVI to VGA

660408-001 16X DVD±RW SuperMulti drive

661841-001 120 GB Solid-state drive (SSD), SATA 2.0

661842-001 256 GB Solid-state drive (SSD), SATA 6.0

662723-001 Adapter, DisplayPort (DP) to DVI

663213-001 USB 3.0 SuperSpeed PCI-3 x1 card, includes 2 external Type A ports and 2 internal ports

663214-001 SATA USB 3.0 SuperSpeed power extension cable, 20 in

665119-001 Intel Celeron G540 processor, 2.5 GHz

665120-001 Intel Core i3 2130 processor, 3.4 GHz

665123-001 Intel Pentium Dual-Core G860 processor, 3.0 GHz

671612-001 Memory module, 2-GB, PC3 12800, 1666-MHz

671613-001 Memory module, 4-GB, PC3 12800, 1666-MHz

674314-001 Keyboard, wireless, for use in the United States

Spare parts 35



Spare part
number

Description

682411-001 ATI Radeon HD7450 PCIe x16 graphics card, 1 GB (includes adapter)

695080-001 Front bezel

674314-121 Keyboard, wireless, for use in French Canada

674317-001 Mouse, wireless

674319-001 Wireless keyboard/mouse transceiver

676358-001 System board (standard) (includes replacement thermal material)

680653-001 nVidia Quadro NVS310 PCIe x16 graphics card

682410-001 Intel Celeron G460 processor, 1.8 GHz

682550-001 16X DVD-ROM drive

688162-001 Intel Core i5 3570 processor, 3.4 GHz

688952-001 Chassis stand

689370-001 Intel Core i7 3770s processor, 3.1 GHz

689375-001 Memory module, 8-GB, PC3 12800, 1666-MHz

691934-001 Intel Celeron G550 processor, 2.6 GHz

691935-001 Intel Pentium Dual-Core G640 processor, 2.8 GHz

691936-001 Intel Pentium Dual-Core G870 processor, 3.1 GHz

695077-001 Intel Core i5 3470s processor, 2.9 GHz

695078-001 Intel Core i5 3475s processor, 2.9 GHz

695079-001 Intel Core i5 3570s processor, 3.1 GHz

695080-001 Front bezel
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7 Removal and Replacement Procedures
Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

NOTE: Not all features listed in this guide are available on all computers.

Serial Number Location
Each computer has a unique serial number and product ID number in the location shown below. Keep
these numbers available for use when contacting customer service for assistance.

Figure 7-1  Serial Number and Product ID Location

Preparation for Disassembly
See Identifying the Chassis, Routine Care, and Disassembly Preparation on page 19 for initial safety
procedures.

1. Remove/disengage any security devices that prohibit opening the computer (Installing a Security
Lock on page 86).

2. Close any open software applications.
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3. Exit the operating system.

4. Remove any compact disc or media card from the computer.

5. Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

6. Disconnect the power cord from the electrical outlet and then from the computer.

7. Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Computer Access Panel

Description Spare part number

Access panel 636924-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. If the computer is on a stand, remove the computer from the stand.

3. Loosen the captive thumbscrew (1), then lift the access panel off the computer (2).

Figure 7-2  Removing the Access Panel

To install the access panel, reverse the removal procedure.
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Front Bezel

Description Spare part number

Front bezel 695080-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 7-3  Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks

Description Spare part number

5.25-inch bezel blank 570838-001

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1. Remove the access panel (Computer Access Panel on page 39).

2. Remove the front bezel (Front Bezel on page 40)..

3. To remove a bezel blank, push the two retaining tabs that hold the bezel blank in place towards
the outer right edge of the bezel (1) and slide the bezel blank back and to the right to remove it
(2).

Figure 7-4  Removing a Bezel Blank

4. Replace the front bezel.
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System Board Connections
Refer to the following illustration and table to identify the system board connectors.

Figure 7-5  System Board Connections

Table 7-1  System Board Connections

No. System Board Connector System Board Label Color Component

1 DIMM (Channel A) XMM3 black Memory Module

2 DIMM (Channel B) XMM1 black Memory Module

3 Power SATAPWR1 black SATA Drives

4 Media Card Reader MEDIA1 black Media Card Reader

5 SATA SATA1 white Optical Drive

6 SATA SATA0 dark blue Hard Drive

7 PCI Express x1 X1PCIEXP1 black Expansion Card

8 PCI Express x16 X16PCIEXP black Expansion Card

9 PCI (2) PCI1 and PCI2 white Expansion Card
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Installing Additional Memory

Description Spare part number

8-GB, PC3-12800 689375-001

4-GB, PC3-12800 671613-001

2-GB, PC3-12800 671612-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to two industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory configured in a high-
performing dual channel mode.

DDR3-SDRAM DIMMs

For proper system operation, the DDR3-SDRAM DIMMs must be:

● industry-standard 240-pin

● unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

● 1.5 volt DDR3-SDRAM DIMMs

The DDR3-SDRAM DIMMs must also:

● support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

● contain the mandatory JEDEC SPD information

In addition, the computer supports:

● 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

● single-sided and double-sided DIMMs

● DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are two DIMM sockets on the system board: XMM1 and XMM3 with one socket per Channel.
XMM3 operates in memory channel A. XMM1 operates in memory Channel B.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

● The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

● The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMM in Channel A is equal to the total memory capacity of the DIMM in Channel B.

● The system will operate in flex mode if the total memory capacity of the DIMM in Channel A is
not equal to the total memory capacity of the DIMM in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. If one channel will have more
memory than the other, the larger amount should be assigned to Channel A.

● In any mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).
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3. Rotate up the drive bay housing to access the memory module sockets on the system board.

Figure 7-6  Rotating the Drive Cage Up

4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 7-7  Installing a DIMM

NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the black XMM1 socket.

For maximum performance, populate the sockets so that the memory capacity is equal between
Channel A and Channel B. Refer to Populating DIMM Sockets on page 44 for more information.

5. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).
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6. Rotate the drive cage back down to its normal position.

Figure 7-8  Rotating the Drive Cage Down

7. Replace the access panel.

8. If the computer was on a stand, replace the stand.

9. Reconnect the power cord and turn on the computer.

10. Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the
computer.

Removing or Installing an Expansion Card

Description Spare part number

ATI HD6350, 512-MB PCIe x16 graphics card 637995-001

nVidia Quadro NVS310 PCIe x16 graphics card 680653-001

nVidia Quadro NVS300 PCIe x16 graphics card 632486-001

ATI Radeon HD7450 PCIe x16 graphics card, 1 GB (includes adapter) 682411-001

AMD FirePro 2270 PCIe x16 graphics card, 512-MB 637213-001

USB 3.0 SuperSpeed PCI-3 x1 card, includes 2 external Type A ports and 2 internal ports 663213-001

USB 3.0 SuperSpeed PCI-3 x1 card, includes 2 external Type A ports 608151-001

HP WLAN 802.11 g/n 1x2 PCIe NIC 538048-001

Intel PRO/1000CT2 NIC, includes bracket 635523-001

HP FireWire / IEEE 1394a PCIe x1 Card 637591-001

Printer port 638817-001

Serial port, full height 638815-001

The computer has two PCI expansion slots, one PCI Express x1 expansion slot, and one PCI
Express x16 expansion slot.
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NOTE: The PCI and PCI Express slots support only low profile cards.

NOTE: You can install a PCI Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.

To install an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.

4. Release the slot cover retention latch that secures the slot covers by lifting the green tab on the
latch and rotating the latch to the open position.

Figure 7-9  Opening the Expansion Slot Retainer
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5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

a. If you are installing an expansion card in a vacant socket, remove the appropriate
expansion slot cover on the back of the chassis. Pull the slot cover straight up then away
from the inside of the chassis.

Figure 7-10  Removing an Expansion Slot Cover
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b. If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end,
and carefully rock it back and forth until the connectors pull free from the socket. Pull the
expansion card straight up from the socket (1) then away from the inside of the chassis to
release it from the chassis frame (2). Be sure not to scrape the card against the other
components.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

Figure 7-11  Removing a PCI Express x1 Expansion Card
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c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket
then away from the inside of the chassis to release it from the chassis frame. Be sure not to
scrape the card against the other components.

Figure 7-12  Removing a PCI Express x16 Expansion Card

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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8. To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis (1) so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the
expansion socket on the system board (2).

Figure 7-13  Installing an Expansion Card

NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

9. Rotate the slot cover retention latch back in place to secure the expansion card.

Figure 7-14  Closing the Expansion Slot Retainer

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Replace the access panel.

12. If the computer was on a stand, replace the stand.
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13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the access panel was removed.

15. Reconfigure the computer, if necessary.
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Cable Management
The Small Form Factor chassis is a very compact computer and proper routing of the internal cables
is critical to the operation of the computer. Follow good cable management practices when working
inside the computer.

● Keep cables away from major heat sources like the heat sink.

● Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

● Keep cables clear of movable or rotating parts like the power supply and drive cage to prevent
them from being cut or crimped when the component is lowered into its normal position.

● When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

● Some flat ribbon cables come prefolded. Never change the folds on these cables.

● Do not bend any cable sharply. A sharp bend can break the internal wires.

● Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

● Never crease a SATA data cable.

● Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the connector on the system board, always
follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.
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Drives

Description Spare part number

Optical drives:  

6X BD-Writer SuperMulti drive 656792-001

16X DVD±RW SuperMulti drive 660408-001

16X DVD-ROM drive 682550-001

Hard drives:  

1 TB hard drive 636930-001

500 GB hard drive 636929-001

250 GB hard drive 636927-001

256 GB Solid-state drive (SSD), SATA 6.0 661842-001

120 GB Solid-state drive (SSD), SATA 2.0 661841-001

Drive cables:  

SATA cable, 2 straight ends (19 inch, 483 mm) 638813-001

SATA cable, 1 straight end, 1 angled end (25-inch (635 mm) 638814-001

SATA power cable 636923-001

A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary
hard drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.
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Drive Positions

Figure 7-15  Drive Positions

Table 7-2  Drive Positions

1 3.5-inch internal hard drive bay

2 3.5-inch internal drive bay for optional drives (media card reader shown)

3 5.25-inch internal drive bay for optional drives (optical drive shown)

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup.

Installing and Removing Drives

When installing additional drives, follow these guidelines:

NOTE: Refer to System Board Connections on page 42 for an illustration of the system board drive
connectors.

● The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATA0.

● Connect a SATA optical drive to the white SATA connector on the system board labeled SATA1.

● Connect a media card reader USB cable to the USB connector on the system board labeled
MEDIA1.

● The power cable for the SATA drives is a three-headed cable that is plugged into the system
board with the first connector routed to the rear of the hard drive, the second connector routed to
the rear of the 3.5” drive, and the third connector routed to the rear of the 5.25” optical drive.

● The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

● You must install mounting screws to ensure the drive will line up correctly in the drive cage and
lock in place. HP has provided extra mounting screws for the internal drive bays (five 6-32
standard screws and four M3 metric screws), installed in the front of the chassis, under the front
bezel. The 6-32 standard screws are required for a secondary hard drive (not supported). All
other drives (except the primary hard drive) use M3 metric screws. The HP-supplied metric
screws are black and the HP-supplied standard screws are silver.
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NOTE:  If you are replacing the primary hard drive, you must remove the four silver and blue
6-32 isolation mounting screws from the old hard drive and install them in the new hard drive.

Figure 7-16  Extra Mounting Screw Locations

Table 7-3  Extra Mounting Screws

No. Mounting Screw Device

1 Black M3 Metric Screws All Drives (except hard drives)

2 Silver 6-32 Standard Screws Secondary Hard Drive (in systems supporting two hard drives)

There are a total of five extra silver 6-32 standard screws. Four are used as mounting screws for a secondary hard
drive (not supported). The fifth is used for bezel security (see Front Bezel Security on page 88 for more
information).

CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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Removing an Internal 5.25-inch Drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove a 5.25-inch internal drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Rotate the drive cage to its upright position (1) and remove the mounting screw on the back left
side of the drive (2).

Figure 7-17  Removing the Drive Mounting Screw

4. Press and hold down the latch to disconnect the power cable (1) and data cable (2) from the rear
of the optical drive.

Figure 7-18  Disconnecting the Power and Data Cables
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5. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 7-19  Rotating the Drive Cage Down

6. Slide the drive back until it stops, then lift it up and out of the drive cage.

Figure 7-20  Removing the 5.25-inch Drive

NOTE: When replacing a drive, transfer the four mounting screws from the old drive to the new one.
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Installing an Optical Drive into the 5.25-inch Drive Bay

To install an optional 5.25-inch optical drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank. See Bezel Blanks on page 41 for more information.

4. Install three M3 metric mounting screws in the lower holes on each side of the drive: two on the
right side and one on the front left side. HP has provided extra M3 metric mounting screws on
the front of the chassis, under the front bezel. The M3 metric mounting screws are black. Refer
to Installing and Removing Drives on page 55 for an illustration of the extra M3 metric mounting
screws location.

CAUTION: Use only 5-mm long screws as mounting screws. Longer screws can damage the
internal components of the drive.

NOTE: When replacing the drive, transfer the three M3 metric mounting screws from the old
drive to the new one.

Figure 7-21  Installing Mounting Screws in the Optical Drive

5. Position the mounting screws on the drive into the J-slots in the drive bay. Then slide the drive
toward the front of the computer until it stops.

Figure 7-22  Installing the Optical Drive
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6. Rotate the drive cage to its upright position (1) and install an M3 mounting screw in the back left
side of the drive (2) to secure the drive to the drive cage.

Figure 7-23  Securing the Drive in the Drive Cage

7. Connect the SATA data cable to the white system board connector labeled SATA1 if it is not
already connected.

8. Route the data cable through the cable guides.

CAUTION: There are two cable guides that keep the data cable from being pinched by the
drive cage when raising or lowering it. One is located on the bottom side of the drive cage. The
other is located on the chassis frame under the drive cage. Ensure that the data cable is routed
through these guides before connecting it to the optical drive.

9. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

NOTE: The power cable for the optical drive is a three-headed cable that is routed from the
system board to the hard drive, then to the rear of the optical drive.

Figure 7-24  Connecting the Power and Data Cables
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10. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 7-25  Rotating the Drive Cage Down

11. Replace the access panel.

12. If the computer was on a stand, replace the stand.

13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.

Removing an Internal 3.5-inch Drive

CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

The 3.5-inch drive is located underneath the 5.25-inch drive. You must remove the internal 5.25-inch
drive before removing the internal 3.5-inch drive.

1. Follow the procedure in Removing an Internal 5.25-inch Drive on page 57 to remove the 5.25-
inch drive and access the 3.5-inch drive.

CAUTION: Ensure that the computer is turned off and that the power cord is disconnected
from the electrical outlet before proceeding.
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2. If you are removing a media card reader, disconnect the USB cable from the system board.

Figure 7-26  Disconnecting the Media Card Reader USB Cable

3. Rotate the drive cage to its upright position (1) and remove the mounting screw on the back left
side of the drive (2).

Figure 7-27  Removing the Drive Mounting Screw

4. Rotate the drive cage back down to its normal position.

Figure 7-28  Rotating the Drive Cage Down
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5. Slide the drive back until it stops, then lift it up and out of the drive cage.

Figure 7-29  Removing a 3.5-inch Drive (Media Card Reader Shown)

NOTE: When replacing a 3.5-inch drive, transfer the four mounting screws from the old drive to the
new one.

Installing a Drive into the 3.5-inch Internal Drive Bay

The 3.5-inch bay is located underneath the 5.25-inch drive. To install a drive into the 3.5-inch bay:

1. Follow the procedure in Removing an Internal 5.25-inch Drive on page 57 to remove the 5.25-
inch drive and access the 3.5-inch drive bay.

CAUTION: Ensure that the computer is turned off and that the power cord is disconnected
from the electrical outlet before proceeding.

2. If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank. See Bezel Blanks on page 41 for more information.

3. Install three M3 metric mounting screws in the lower holes on each side of the drive: two on the
right side and one on the front left side. HP has provided extra M3 metric mounting screws on
the front of the chassis, under the front bezel. The M3 metric mounting screws are black. Refer
to Installing and Removing Drives on page 55 for an illustration of the extra M3 metric mounting
screws location.

CAUTION: Use only 5-mm long screws as mounting screws. Longer screws can damage the
internal components of the drive.

NOTE: When replacing the drive, transfer the three M3 metric mounting screws from the old
drive to the new one.

Figure 7-30  Installing Mounting Screws in the Media Card Reader
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4. Position the mounting screws on the drive into the J-slots in the drive bay. Then slide the drive
toward the front of the computer until it stops.

Figure 7-31  Installing a Drive into the 3.5-inch Drive Bay (Media Card Reader Shown)

5. Rotate the drive cage to its upright position (1) and install an M3 mounting screw in the back left
side of the drive (2) to secure the drive to the drive cage.

Figure 7-32  Securing the Drive in the Drive Cage

6. Rotate the drive cage back down to its normal position.

CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 7-33  Rotating the Drive Cage Down
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7. If installing a media card reader, connect the USB cable from the media card reader to the USB
connector on the system board labeled MEDIA1.

Figure 7-34  Connecting the Media Card Reader USB Cable

NOTE: Refer to System Board Connections on page 42 for an illustration of the system board
drive connectors.

8. Replace the 5.25-inch drive.

9. Replace the access panel.

10. If the computer was on a stand, replace the stand.

11. Reconnect the power cord and turn on the computer.

12. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.
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Removing and Replacing the Primary 3.5-inch Internal SATA Hard Drive

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the
hard drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Rotate the drive cage for internal drives to its upright position.

Figure 7-35  Rotating the Drive Cage Up

4. Rotate the power supply to its upright position. The hard drive is located beneath the power
supply.

Figure 7-36  Raising the Power Supply
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5. Press and hold down the latch to disconnect the power cable (1) and data cable (2) from the
back of the hard drive.

Figure 7-37  Disconnecting the Hard Drive Power Cable and Data Cable

6. Press down on the green release latch next to the hard drive (1). While holding the latch down,
slide the drive forward until it stops, then lift the drive up and out of the bay (2).

Figure 7-38  Removing the Hard Drive

7. To install a hard drive, you must transfer the silver and blue isolation mounting screws from the
old hard drive to the new hard drive.

Figure 7-39  Installing Hard Drive Mounting Screws
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8. Align the mounting screws with the slots on the chassis drive cage, press the hard drive down
into the bay, then slide it back until it stops and locks in place.

Figure 7-40  Installing the Hard Drive

9. Connect the power and data cables to the back of the hard drive.

NOTE: When replacing the primary hard drive, be sure to route the SATA and power cables
through the cable guide on the bottom of the chassis frame behind the hard drive.

The data cable must be connected to the dark blue connector labeled SATA0 on the system
board to avoid any hard drive performance problems.

10. Rotate the drive cage for internal drives and the power supply down to their normal positions.

11. Replace the access panel.

12. If the computer was on a stand, replace the stand.

13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the access panel was removed.
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Baffle

Description Spare part number

Baffle 636921-001

The baffle sits between the front fan and the heat sink.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Remove the cables from the holder on the side of the baffle.

4. Lift the baffle straight up out of the chassis.

Figure 7-41  Removing the baffle

To install the baffle, reverse the removal procedure.
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Front Fan Assembly

Description Spare part number

Front fan assembly 636922-001

The front fan assembly is attached to the front of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Remove the front bezel (Front Bezel on page 40).

4. Remove the baffle (Baffle on page 69).

5. Disconnect the fan cable from the red/brown system board connector labeled CHFAN.

6. Press the two tabs (left, bottom) that secure the fan assembly to the chassis front.

Figure 7-42  Front fan tab locations

7. Pull the assembly toward the rear of the unit, and then lift it out of the chassis.

Figure 7-43  Removing the front fan

To install the front fan, reverse the removal procedure. Be sure to orient the air flow into the unit.
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Front I/O, Power Switch Assembly

Description Spare part number

Front I/O and power switch assembly 636926-001

The front I/O and power switch/LEDs are one assembly, attached to the front of the chassis. Push the
assembly into the chassis to remove.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Remove the front bezel (Front Bezel on page 40).

4. Remove the chassis fan (Front Fan Assembly on page 70).

5. Rotate the drive cage to its upright position.

6. Disconnect the four cables from the system board as follows:

● Yellow connector labeled FRONT USB1

● Green connector labeled FRONT USB2

● Blue connector labeled FRONT AUD

● Black connector labeled PB/LED

7. Remove the screw that secures the assembly to the front of the chassis.

Figure 7-44  Removing the front I/O, power switch/LED assembly screw
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8. Route the cables through the slots beneath the drive cage, pull the assembly (right side first) into
the chassis, and then remove the assembly from the computer.

Figure 7-45  Routing the cables and removing the power switch assembly

To install the front I/O and power switch assembly, reverse the removal procedure.

NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly.

Speaker

Description Spare part number

Speaker 636925-001

The speaker is attached to the front of the chassis under the rotating drive cage.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Remove the front bezel (Front Bezel on page 40).

4. Rotate the drive cage to its upright position.

5. Disconnect the speaker wire from the white system board labeled SPKR

6. Remove the two screws that secure the speaker to the chassis (1).
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7. Lift the speaker from the inside of the chassis to remove it (2).

Figure 7-46  Removing the speaker

To install the speaker, reverse the removal procedures.

Heat sink

Description Spare part number

Heat sink 636919-001

The heat sink is secured atop the processor with four captive Torx screws. The heat sink does not
include a fan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Remove the baffle (Baffle on page 69).

4. Remove the chassis fan (Front Fan Assembly on page 70).
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5. Loosen the four captive screws that secure the heat sink to the system board tray.

CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in
an X) to even the downward forces on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

Figure 7-47  Removing the heat sink screws
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6. Lift the heat sink from atop the processor and set it on its side to keep from contaminating the
work area with thermal grease.

Figure 7-48  Removing the heat sink

When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink on the processor to avoid damage that could require replacing the system
board.

Failure to install the baffle may cause the computer to overheat.
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Processor

Description Spare part number

Intel Core i7 3770s processor, 3.1 GHz 689370-001

Intel Core i5 3570 processor, 3.4 GHz 688162-001

Intel Core i5 3570s processor, 3.1 GHz 695079-001

Intel Core i5 3475s processor, 2.9 GHz 695078-001

Intel Core i5 3470s processor, 2.9 GHz 695077-001

Intel Core i3 2130 processor, 3.4 GHz 665120-001

Intel Core i3 2120 processor, 3.3 GHz 638629-001

Intel Pentium Dual-Core G870 processor, 3.1 GHz 691936-001

Intel Pentium Dual-Core G860 processor, 3.0 GHz 665123-001

Intel Pentium Dual-Core G640 processor, 2.8 GHz 691935-001

Intel Celeron G550 processor, 2.6 GHz 691934-001

Intel Celeron G540 processor, 2.5 GHz 665119-001

Intel Celeron G460 processor, 1.8 GHz 682410-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Remove the baffle (Baffle on page 69).

4. Remove the heat sink (Heat sink on page 73).

5. Rotate the locking lever to its full open position (1).

6. Raise and rotate the microprocessor retainer to its fully open position (2).
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7. Carefully lift the processor from the socket (3).

CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 7-49  Removing the processor

To install a new processor:

1. Place the processor in its socket and close the retainer.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.

3. If reusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided
in the spares kit.

CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the
bottom of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heat sink atop the processor.

5. Go to step 7.
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6. If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

7. Secure the heat sink to the system board and system board tray with the four captive screws
and attach the heat sink control cable to the system board.

CAUTION: heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

Description Spare part number

Power supply, 240W, 85% efficiency 613663-001

Power supply, 240W, High voltage protection 613664-001

Power supply, 240W 613763-001

WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The rotating power supply is located at the rear of the chassis. It is held in place by a bracket – no
screws are used.

WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. Rotate the drive cage up and disconnect the power cables from all of the drives.

4. Disconnect the power cables from the system board connectors labeled PWRCPU, PWR, and
PWRCMD.

5. Rotate the power supply to its full upright position.

6. Release the power supply cables from the cable retaining clip under the drive cage.
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7. Pull the power supply forward (1) until the posts (2) on the power supply move forward in the
power supply bracket, and then lift the power supply straight up and out of the chassis.

Figure 7-50  Removing the power supply

Use the following table to determine the correct power supply/system board connections.

Table 7-4  Power supply cable – system board connector

Power supply connector label System board connector

P1 PWR

P2 PWRCMD

P3 PWRCPU

To install the power supply, reverse the removal procedure.

CAUTION: When installing the power supply cables, make sure they are properly positioned so
they are not cut by the drive cage and are not pinched by the rotating power supply.
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System Board

Description Spare part number

System board – standard (includes thermal material) 676358-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

3. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:

● Memory modules (seeInstalling Additional Memory on page 43)

● Expansion cards (Removing or Installing an Expansion Card on page 46)

● Heat sink (Heat sink on page 73)

● Processor (Processor on page 76)

4. Remove the baffle from the chassis (Baffle on page 69).

5. Remove the fan from the chassis (Front Fan Assembly on page 70).

6. Rotate the drive cage to its upright position.

7. Rotate the power supply to its full upright position.

8. Disconnect all data and power cables from the system board.

9. Disconnect the balance of the cables from the system board.

10. Remove the eight screws (1) that secure the system board to the chassis.
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11. Slide the system board toward the front of the chassis (2), and then lift the rear of the system
board up and out of the chassis (3).

Figure 7-51  Removing the system board

To install the system board, reverse the removal procedure.

NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not
interfere with the rotation of the drive cage or power supply.
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Battery
The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.

Replace the battery only with the HP spare designated for this product.

CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to Computer
Setup (F10) Utility on page 8 for information on backing up the CMOS settings.

NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Remove the access panel (Computer Access Panel on page 39).

NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following
instructions to replace the battery:

82 Chapter 7   Removal and Replacement Procedures Small Form Factor (SFF) Chassis

http://www.hp.com/recycle
http://www.hp.com/recycle


Type 1 Battery Holder

1. Lift the battery out of its holder.

Figure 7-52  Removing the battery from a type 1 holder

2. Slide the replacement battery into position, positive side up.

3. The battery holder automatically secures the battery in the proper position.

4. Replace the computer access panel.

5. Plug in the computer and turn on power to the computer.

6. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 8.

Type 2 Battery Holder

1. To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

2. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

Figure 7-53  Removing the battery from a type 2 holder
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3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 8.

Type 3 Battery Holder

1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).

2. Insert the new battery and position the clip back in place.

Figure 7-54  Removing the battery from a type 3 holder

3. Replace the computer access panel.

4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 8.
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Using the Small Form Factor Computer in a Tower
Orientation

The Small Form Factor computer can be used in a tower orientation. The HP logo plate on the front
bezel is adjustable for either desktop or tower orientation.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 37).

2. Orient the computer so that its right side is facing down and place the computer in the optional
stand.

Figure 7-55  Changing from Desktop to Tower Orientation

NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the
optional tower stand.

3. Lock any security devices that were disengaged when the access panel was removed.

NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.

Using the Small Form Factor Computer in a Tower Orientation 85



Installing a Security Lock
The security locks displayed below and on the following pages can be used to secure the computer.

HP/Kensington MicroSaver Security Cable Lock

Figure 7-56  Installing a Cable Lock
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Padlock

Figure 7-57  Installing a Padlock
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Front Bezel Security

The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as compact discs or USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

5. If the computer is on a stand, remove the computer from the stand.

6. Remove the access panel and front bezel.

7. Remove one of the five silver 6-32 standard screws located on the front of the chassis behind
the bezel.

Figure 7-58  Retrieving the Front Bezel Security Screw

8. Replace the front bezel.
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9. Install the security screw next to the middle front bezel release tab to secure the front bezel in
place.

Figure 7-59  Installing the Front Bezel Security Screw

10. Replace the access panel.

11. If the computer was on a stand, replace the stand.

12. Reconnect the power cord and turn on the computer.

13. Lock any security devices that were disengaged when the access panel was removed.
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A Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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B POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table B-1  Numeric Codes and Text Messages

Control panel message Description Recommended action

ERROR: No boot disk has been detected or
the disk has failed.

The computer cannot read the boot sector
of the boot disk.

1. Check drive data and power cables.

2. Use F10 Setup to make sure the first
boot device is set to drive C or the
primary hard drive.

3. The drive has failed due to mechanical
or virus corruption. Replace the drive.

Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

5. Replace the system board.

511-CPU Fan not Detected CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.

2. Reseat fan cable.

3. Replace CPU fan.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

Unsupported CPU Recently installed processor is not
supported by the system.

Install a processor supported by your
system.

Time & Date Not Set Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

CMOS jumper may not be properly
installed.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery.

Check for proper placement of the CMOS
jumper if applicable.
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Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of
the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table B-2  Diagnostic Front Panel LEDs and Audible Codes

Activity Blinks Possible Cause Recommended Action

Red Power LED flashes
two times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

2 Processor thermal protection
activated:

A fan may be blocked or not
turning.

OR

The heat sink/fan assembly
is not properly attached to
the processor.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not
spinning, make sure the fan's cable is plugged
onto the system board header.

3. If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4. Contact an authorized reseller or service
provider.

Red Power LED flashes
three times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

3 Processor not installed (not
an indicator of bad
processor).

1. Check to see that the processor is present.

2. Reseat the processor.
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Table B-2  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Blinks Possible Cause Recommended Action

Red Power LED flashes
four times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

4 Power failure (power supply
is overloaded).

OR

The incorrect external power
supply adapter is being used
on the USDT.

1. Open the hood and ensure the 4 or 6-wire power
supply cable is seated into the connector on the
system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as hard,
diskette, or optical drives, and expansion cards).
Power on the system. If the system enters the
POST, then power off and replace one device at
a time and repeat this procedure until failure
occurs. Replace the device that is causing the
failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

3. Replace the power supply.

4. Replace the system board.

OR

The USDT power supply adapter must be at 135W
and use the Smart ID technology before the system
will power up. Replace the power supply adapter with
the HP-supplied USDT power supply adapter.

Red Power LED flashes
five times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the DIMMs or the
system board, you must unplug the computer power
cord before attempting to reseat, install, or remove a
DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Red Power LED flashes
six times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the
system board.

Red Power LED flashes
eight times, once every
second, followed by a two
second pause. Beeps stop
after fifth iteration but
LEDs continue until
problem is solved.

8 Invalid ROM based on bad
checksum.

1. Reflash the system ROM with the latest BIOS
image.

2. Replace the system board.
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C Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette
drive, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter
problems with the computer, refer to the tables in this chapter for probable causes and recommended
solutions.

NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to POST Error Messages on page 92.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. For more information, refer to the Regulatory, Safety
and Environmental Notices guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

● Run the HP diagnostic tool.

● Run the hard drive self-test in Computer Setup. Refer to the Computer Setup (F10) Utility Guide
for more information.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to POST Error Messages
on page 92 for more information.

● If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

● If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and see if the computer functions
properly.

● If you recently installed new software, uninstall the software and see if the computer functions
properly.
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● Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

● Refer to the comprehensive online technical support at http://www.hp.com/support.

● Refer to Helpful Hints on page 97 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/
go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

● Be in front of your computer when you call.

● Write down the computer serial number, product ID number, and monitor serial number before
calling.

● Spend time troubleshooting the problem with the service technician.

● Remove any hardware that was recently added to your system.

● Remove any software that was recently installed.

● Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in HP Backup and Recovery Manager.

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

● Check that the computer and monitor are plugged into a working electrical outlet.

● Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

● Check that the computer is turned on and the green power light is on.

● Check that the monitor is turned on and the green monitor light is on.

● Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to POST Error Messages
on page 92 for more information.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.
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● Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

● Check all cable connections for loose connections or incorrect connections.

● Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

● Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 121 for instructions.

● Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

● Remove all bootable media (diskette, CD, or USB device) from the system before turning it on.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

● If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table C-1  Solving General Problems

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date
and time). If the problem persists, replace the RTC battery.
See the Hardware Reference Guide for instructions on
installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause Solution

System volume may be set low or muted. 1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause Solution

Smart Cover Lock, featured on some computers, is locked. Unlock the Smart Cover Lock using Computer Setup.

The Smart Cover FailSafe Key, a device for manually
disabling the Smart Cover Lock, is available from HP. You
will need the FailSafe Key in case of forgotten password,
power loss, or computer malfunction. Order PN 166527-001
for the wrench-style key or PN 166527-002 for the
screwdriver bit key.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on
the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive. Run virus protection program.
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Table C-1  Solving General Problems (continued)

Poor performance is experienced.

Cause Solution

Too many applications running. 1. Close unnecessary applications to free up memory.

2. Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start >
Run (Windows XP), Start > Accessories > Run
(Windows Vista), or click on the Windows 7 start icon in
the bottom left corner of the screen (Windows 7) and
type msconfig. On the Startup tab of the System
Configuration Utility, clear applications that you do not
want to launch automatically.

Some software applications, especially games, are stressful
on the graphics subsystem

1. Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

2. Add more memory.

3. Upgrade the graphics solution.

Cause unknown. Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1. Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3. Replace the system board.

OR

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1. Check that the unit is plugged into a working AC outlet.

2. Open hood and check that the power button harness is
properly connected to the system board.

3. Check that both power supply cables are properly
connected to the system board.

4. Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button harness.

5. If the 5V_aux light on the system board is off, then
replace the power supply.

6. Replace the system board.
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Solving Power Problems
Common causes and solutions for power problems are listed in the following table.

Table C-2  Solving Power Problems

Power supply shuts down intermittently.

Cause Solution

Voltage selector switch on rear of computer chassis (some
models) not switched to correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Contact an authorized service provider to replace the power
supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated:

A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2. Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

3. If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Power failure (power supply is overloaded). 1. Check that the voltage selector, located on the rear of
the power supply (some models), is set to the
appropriate voltage. Proper voltage setting depends on
your region.

2. Open the hood and ensure the 4- or 6-wire power
supply cable is seated into the connector on the system
board.

3. Check if a device is causing the problem by removing
ALL attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If
the system enters the POST, then power off and
replace one device at a time and repeat this procedure
until failure occurs. Replace the device that is causing
the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.

The incorrect external power supply adapter is being used on
the USDT.

The USDT power supply adapter must be at 135W and use
the Smart ID technology before the system will power up.
Replace the power supply adapter with the HP-supplied
USDT power supply adapter.
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Solving Hard Drive Problems

Table C-3  Solving Hard Drive Problems

Hard drive error occurs.

Cause Solution

Hard disk has bad sectors or has failed. 1. In Microsoft Windows XP, right-click Start, click
Explore, and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

In Microsoft Windows Vista and Windows 7, right-click
Start, click Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-
checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause Solution

Either the directory structure is bad or there is a problem with
a file.

In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking, click Check Now.

In Microsoft Windows Vista and Windows 7, right-click Start,
click Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-checking
click Check Now.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 121 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Nonsystem disk/NTLDR missing message.

Cause Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

System files missing or not properly installed. 1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup. Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board connector labeled P60 SATA 0.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged. Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See POST Error Messages
on page 92 to determine possible causes for the blinking red
and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer seems to be locked up.

Cause Solution

Program in use has stopped responding to commands. Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

The removable hard drive has no power to the hard drive enclosure.

Cause Solution

The lock on the enclosure is not turned to the “ON” position. Insert the key and turn the lock clockwise 90 degrees. The
green LED on the front of the enclosure should be on.

Power cable from the computer power supply to the
enclosure frame is not properly connected.

Check the power supply to make sure it is properly
connected to the rear of the enclosure frame.

The removable hard drive is not recognized by the computer.

Cause Solution

The removable hard drive carrier is not fully seated in the
enclosure frame or the hard drive is not fully seated in the
carrier.

Push the carrier into the enclosure frame so that the
connector on the rear of the frame is properly seated. If this
does not solve the problem, turn off the computer, remove
the carrier, and check to see if the connector on the hard
drive is properly seated in the carrier.

The removable hard drive enclosure is beeping and the green LED is flashing.

Cause Solution

Fan failure alarm on the removable hard drive enclosure has
been activated.

Shut down the computer and contact HP for a replacement
enclosure.
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Solving Media Card Reader Problems

Table C-4  Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Microsoft Windows.

Cause Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Most
digital cameras use the FAT (FAT16 & FAT12) format and
can not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. Open My Computer (Windows XP), Computer (Windows
Vista), or Devices and Printers (Windows 7), right-click on
the corresponding drive icon, and select Eject. Then pull the
card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized
by the computer.

Cause Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.
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Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Table C-5  Solving Display Problems

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector. If the computer system has both an integrated graphics
connector and an add-in graphics card connector, plug the
monitor cable into the graphics card connector on the back of
the computer.

Monitor settings in the computer are not compatible with the
monitor.

1. In Windows XP Control Panel, double-click the Display
icon and select the Settings tab.

In Windows Vista Control Panel, under Appearance
and Personalization, select Adjust screen
resolution.

In Windows 7, right click in an empty space on the
desktop and select Screen Resolution.

2. Reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.
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Cannot enable integrated graphics after installing a PCI Express graphics card.

Cause Solution

On systems with Intel integrated graphics, the integrated
graphics cannot be enabled after installing a PCI Express
x16.

The integrated graphics can be enabled in Computer Setup if
a PCI or PCI Express x1 graphics card is installed, but it
cannot be enabled if there is a graphics card in the PCI
Express x16 slot.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.
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Dim characters.

Cause Solution

The brightness and contrast controls are not set properly. Adjust the monitor brightness and contrast controls.

Cables are not properly connected. Check that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution. Change requested resolution.

Graphics card is bad. Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed. Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause Solution

Position may need adjustment. Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause Solution

Monitor video cable is disconnected. Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.
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“Out of Range” displays on screen.

Cause Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause Solution

Monitor degaussing coil has been activated. None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a CRT monitor.

Cause Solution

Electronic relays have been activated inside the monitor. None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause Solution

Brightness and/or contrast settings are too high. Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of
the graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad. 1. Reseat the graphics card.

2. Replace the graphics card.
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Certain typed symbols do not appear correct.

Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the symbol
from the Character Map into a document.
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Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.

Table C-6  Solving Audio Problems

Sound cuts in and out.

Cause Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Direct sound latency, common in many media player
applications.

In Windows XP only:

1. From the Control Panel, select Sounds and Audio
Devices.

2. On the Audio tab, select a device from the Sound
Playback list.

3. Click the Advanced button and select the Performance
tab.

4. Set the Hardware acceleration slider to None and the
Sample rate conversion quality slider to Good and
retest the audio.

5. Set the Hardware acceleration slider to Full and the
Sample rate conversion quality slider to Best and
retest the audio.

Sound does not come out of the speaker or headphones.

Cause Solution

Software volume control is turned down or muted. Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup. Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on. Turn on the external speakers.

The audio device may be connected to the wrong jack. Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled. Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.
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Table C-6  Solving Audio Problems (continued)

Sound does not come out of the speaker or headphones.

Cause Solution

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup. Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause Solution

The hard disk may be full. Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Table C-7  Solving Printer Problems

Printer will not print.

Cause Solution

Printer is not turned on and online. Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.

2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on.

Cause Solution

The cables may not be connected properly. Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause Solution

The correct printer driver for the application is not installed. Install the correct printer driver for the application.
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Table C-7  Solving Printer Problems (continued)

Printer prints garbled information.

Cause Solution

The cables may not be connected properly. Reconnect all cables.

Printer memory may be overloaded. Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause Solution

The printer may be out of paper. Check the paper tray and refill it if it is empty. Select online.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Table C-8  Solving Keyboard Problems

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. On the Windows XP Desktop, click Start > Shut Down.

On the Windows Vista or Windows 7 desktop, click
Start, click the arrow on the lower right corner of the
Start menu, then select Shut Down.

2. After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.

Table C-9  Solving Mouse Problems

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.

1. Press the Ctrl and Esc keys at the same time (or press
the Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then
press the Enter key.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.
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Table C-9  Solving Mouse Problems (continued)

Mouse does not respond to movement or is too slow.

Cause Solution

Program in use has stopped responding to commands. Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning. Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair. See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non–plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Table C-10  Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause Solution

Device is not seated or connected properly. Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on. Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > Device Security.

Computer will not start.

Cause Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM 1 must always be installed.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM 1 must always be installed.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.
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Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table C-11  Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Saving.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows XP:

1. Select Start > Control Panel.

2. Double-click Network Connections.

3. Double-click Local Area Connection.

4. Click Properties.

5. Click Configure.

6. Click the Power Management tab, then select the
check box to Allow this device to bring the computer
out of standby.

To enable Wake-on-LAN in Windows Vista:

1. Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. In the Tasks list, select Manage network connections.

4. Double-click Local Area Connection.

5. Click the Properties button.

6. Click the Configure button.

7. Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 7:

1. Select Start  > Control Panel.

2. Under Network and Sharing Center, click Change
adapter settings.

3. Right-click the network connection you want to enable
WOL on and click Properties.

4. Click Configure.

5. Select Allow this device to wake the computer.

6. Click OK.
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Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver. Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution

No active network is detected. Check cabling and network equipment for proper connection.

Network controller is not set up properly. Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded. Reinstall network drivers.

System cannot autosense the network. Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause Solution

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector. Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective. Contact an authorized service provider.
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Diagnostics passes, but the computer does not communicate with the network.

Cause Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer. Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers. Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.
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System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.

CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

Table C-12  Solving Memory Problems

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the XMM1 (or DIMM1)
socket.

Ensure that a memory module is installed in the black XMM1
(or DIMM1) socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for
the system or the new memory module is not seated
properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause Solution

Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.

You have run out of memory to run the application. Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.
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Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs)
are installed.

Delete any TSRs that you do not need.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Table C-13  Solving Processor Problems

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously
enabled on this system.

1. Install a TXT capable processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.
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Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

Table C-14  Solving CD-ROM and DVD Problems

System will not boot from CD-ROM or DVD drive.

Cause Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup. Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.

Non-bootable CD in drive. Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause Solution

Cable could be loose. Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 121 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up. Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause Solution

Drive is not connected properly or not properly configured. See the documentation that came with the optional device.

Solving CD-ROM and DVD Problems 129



Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.

Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.

2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.
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USDT computer boots too slow after removing a CD-ROM or DVD drive.

Cause Solution

The system is searching for the drive during boot because
the drive cable is still attached to the system board.

Disconnect the drive cable from the system board.

Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

Table C-15  Solving USB Flash Drive Problems

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The image on the device is not bootable. Follow the procedures described in the “ROM Flash:
Replicating the Setup: Creating a Bootable Device:
Supported USB Flash Media Device” section of the Service
Reference Guide.

The computer boots to DOS after making a bootable flash drive.

Cause Solution

Flash drive is bootable. Install the flash drive only after the operating system boots.
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Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

Table C-16  Solving Front Panel Component Problems

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup. Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > Device Security.
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Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Table C-17  Solving Internet Access Problems

Unable to connect to the Internet.

Cause Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly. Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in. Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected. Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)

IP address is not configured properly. Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser
remember some specific information that the Web server can
later retrieve.)

Windows Vista

1. Select Start > Control Panel.

2. Click Network and Internet.

3. Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Click the Delete cookies button.

Windows XP

1. Select Start > Control Panel.

2. Double-click Internet Options.

3. On the General tab, click the Delete Cookies button.

Windows 7

1. Select Start > Control Panel.

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Click the Delete cookies button.
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Cannot automatically launch Internet programs.

Cause Solution

You must log on to your ISP before some programs will start. Log on to your ISP and launch the desired program.
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Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.

Windows XP

1. Select Start > Control Panel.

2. Double-click System.

3. Click the Hardware tab.

4. In the Device Manager area, click the Device Manager
button.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Windows Vista

1. Select Start > Control Panel.

2. Click on System and Maintenance.

3. Click on System.

4. In the Tasks list, select Device Manager.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Windows 7

1. Select Start > Control Panel.

2. Click on System.

3. In the Tasks list, select Device Manager.

4. Double-click Modems.

5. Double-click Agere Systems PCI-SV92PP Soft
Modem.

6. On the General tab, click Diagnostics.

7. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving Software Problems
Most software problems occur as a result of the following:

● The application was not installed or configured correctly.

● There is insufficient memory available to run the application.

● There is a conflict between applications.

● Be sure that all the needed device drivers have been installed.

● If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Table C-18  Solving Software Problems

Computer will not continue and no HP logo screen has appeared.

Cause Solution

POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See POST Error Messages on page 92 to
determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause Solution

System files may be damaged. Use recovery diskette to scan hard drive for errors.

“Illegal Operation has Occurred” error message is displayed.

Cause Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt. If possible, save all data, close all programs, and restart the
computer.
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D Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See the Computer Setup (F10) Utility Guide for information on
backing up the CMOS settings.
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Resetting the Password Jumper
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper.

NOTE: The password jumper is green so that it can be easily identified. For assistance
locating the password jumper and other system board components, see the Illustrated Parts &
Service Map (IPSM) for that particular system. The IPSM can be downloaded from
http://www.hp.com/support.

5. Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so
that it does not get lost.

6. Replace the access panel.

7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

9. To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1
and 2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup.
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Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3. Remove the computer cover or access panel.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is
important to back up the computer CMOS settings before resetting them in case they are
needed later. Back up is easily done through Computer Setup.

4. Locate, press, and hold the CMOS button in for five seconds.

NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure D-1  CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM).

5. Replace the computer cover or access panel.
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6. Reconnect the external devices.

7. Plug in the computer and turn on power.

NOTE: You will receive POST error messages after clearing CMOS and rebooting advising
you that configuration changes have occurred. Use Computer Setup to reset any special system
setups along with the date and time.
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E Drive Protection System (DPS)

The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in some
computers. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When these systems are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. Your service provider can use this information to help diagnose conditions that caused you to
run the DPS software.

Running DPS will not affect any programs or data stored on the hard drive. The test resides in the
hard drive firmware and can be executed even if the computer will not boot to an operating system.
The time required to execute the test depends on the manufacturer and size of the hard drive; in most
cases, the test will take approximately two minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer reports a SMART Hard Drive
Detect Imminent Failure message, there is no need to run DPS; instead, back up the information on
the hard drive and contact a service provider for a replacement hard drive.
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Accessing DPS Through Computer Setup
When the computer does not power on properly you should use Computer Setup to access the DPS
program. To access DPS, perform the following steps:

1. Turn on or restart the computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10
key.

NOTE: If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage,
Security, Power, and Advanced.

3. Select Storage  > DPS Self-Test.

The screen will display the list of DPS-capable hard drives that are installed on the computer.

NOTE: If no DPS-capable hard drives are installed, the DPS Self-Test option will not appear
on the screen.

4. Select the hard drive to be tested and follow the screen prompts to complete the testing process.

When the test has been completed, one of three messages will be displayed:

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 or 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

If the test failed, the completion code should be recorded and reported to your service provider for
help in diagnosing the computer problem.
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F System Recovery

System Recovery completely erases and reformats the hard disk drive, deleting all data files you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed
after purchase.

NOTE: Always use the System Restore procedure before you use the System Recovery program.

NOTE: Some features might not be available on systems that are shipped without a version of
Microsoft Windows.

You must choose one of the following methods to perform a System Recovery:

● Recovery Image — Run the System Recovery from a recovery image stored on your hard disk
drive. The recovery image is a file that contains a copy of the original factory-shipped software.
To perform a System Recovery from a recovery image, see System Recovery from the Windows
7 Start Menu on page 144.

NOTE: The recovery image uses a portion of the hard disk drive that cannot be used for data
storage.

● Recovery Media — Run the System Recovery from recovery media, that you created from files
stored on your hard disk drive, or purchased separately. To create recovery media, see
Recovery media on page 146.
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System Recovery options
You should attempt a System Recovery in the following order:

1. Through the hard disk drive, from the Windows 7 Start menu.

2. Through the hard disk drive, by pressing the F11 key on the keyboard during system startup.

3. Through recovery media that you create.

4. Through recovery discs purchased from HP Support. To purchase recovery discs, visit
www.hp.com/support.

System Recovery from the Windows 7 Start Menu

CAUTION: System Recovery deletes all data and programs you created or installed. Back up any
important data to a removable disc or USB flash drive.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.

2. Disconnect all peripheral devices from the computer except the keyboard and mouse.

3. Turn on the computer.

4. Tap the Start button, tap All Programs, tap Recovery Manager, and then tap Recovery
Manager. If prompted, tap Yes to allow the program to continue.

5. Under I need help immediately, tap System Recovery.

6. Tap Yes, and then tap Next. Your computer restarts.

NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media. Insert the disc, or USB flash drive, tap Yes, and then tap Next to restart the computer
and run Recovery Manager from the recovery disc, or the recovery USB flash drive. If using
discs, insert the next system-recovery disc when prompted.

7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, tap System Recovery. If you are prompted to back up your files, and
you have not done so, tap Back up your files first (recommended), and then tap Next.
Otherwise, tap Recover without backing up your files, and then tap Next.

8. System Recovery begins. After System Recovery is complete, tap Finish to restart the
computer.

9. Complete the registration process, and wait until you see the desktop.

10. Turn off the computer, reconnect all peripheral devices, and turn the computer back on.

System Recovery at system startup

CAUTION: System Recovery deletes all data and programs you created or installed. Back up any
important data to a removable disc.
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If Windows 7 is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the Power button until the computer turns
off.

2. Disconnect all peripheral devices from the computer, except the keyboard and mouse.

3. Press the Power button to turn on the computer.

4. As soon as you see the initial company logo screen appear, repeatedly press the F11 key on
your keyboard until the Windows is Loading Files… message appears on the screen.

5. Under I need help immediately, tap System Recovery.

6. If you are prompted to back up your files, and you have not done so, tap Back up your files
first (recommended), and then tap Next. Otherwise, tap Recover without backing up your
files, and then tap Next.

7. System Recovery begins. After System Recovery is complete, tap Finish to restart the
computer.

8. Complete the registration process, and wait until you see the desktop.

9. Turn off the computer, reconnect all peripheral devices, and turn the computer back on.

System Recovery from recovery media

CAUTION: System Recovery deletes all data and programs you created or installed. Back up any
important data to a removable disc, or USB flash drive.

To create recovery media, see Recovery media on page 146.

To perform a System Recovery using recovery media:

1. If the computer is working, create a backup DVD, or backup USB flash drive, containing all the
data files you want to save, and then remove the backup media from the computer.

2. Insert recovery disc #1 into the DVD drive tray, and close the tray; or if using a recovery USB
flash drive, insert it into a USB port.

3. If the computer works, tap the Start button, and then tap Shut Down. Or, if the computer is not
responding, press and hold the Power button for approximately 5 seconds, or until the computer
turns off.

4. Disconnect all peripheral devices from the computer except the keyboard and mouse.

5. Press the Power button to turn on the computer. If you are using a recovery DVD, the computer
will automatically run Recovery Manager from the disc. Skip to step 7.

6. If you are running System Recovery from a USB flash drive, press the Esc key as the computer
is powering on to bring up the boot menu. Use the arrow keys to select the USB device and
press Enter to boot from that device.

7. If the Recovery Manager asks if you want to run System Recovery from Media or Hard Drive,
select Media. On the Welcome screen, under I need help immediately, tap Factory Reset.

System Recovery options 145



8. If you are prompted to back up your files, and you have not done so, tap Back up your files
first (recommended), and then tap Next. Otherwise, tap Recover without backing up your
files, and then tap Next.

9. If you are prompted to insert the next recovery disc, do so.

10. When the Recovery Manager is finished, remove all recovery discs, or the recovery USB flash
drive, from the system.

11. Tap Finish to restart the computer.

Recovery media
You should create a set of recovery discs, or a recovery USB flash drive, from the recovery image
stored on your hard disk drive. This image contains the operating system and software program files
that were originally installed on your computer at the factory. You can create only one set of recovery
discs, or one recovery USB flash drive, for your computer; the recovery discs, or the recovery drive,
can be used only with this computer. Store the recovery discs, or the recovery USB flash drive, in a
safe place.

NOTE: Some features might not be available on systems that are shipped without a version of
Microsoft Windows.

Choosing recovery media

● To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

NOTE: You cannot use CDs or DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL,
or DVD-R DL discs to create recovery discs.

● You have the option of creating a recovery USB flash drive instead, using a high-quality blank
USB drive.

● If you are creating recovery discs, be sure to use high-quality discs. It is normal for discs to be
rejected if they are not defect-free. You will be prompted to insert a new blank disc to try again.

● The number of discs in the recovery-disc set depends on your computer model (typically 3–6
DVD discs). The Recovery Media Creation program tells you the specific number of blank discs
needed to make the set. If you are using a USB flash drive, the program will tell you the size of
the drive required to store all the data (minimum of 8 GB).

NOTE: The process of creating recovery discs, or a recovery USB drive, takes some time to
verify that the information written on the disc, or USB flash drive, is correct. You can quit the
process at any time. The next time you run the program, it resumes where it left off.

Creating recovery media

To create recovery discs:

1. Close all open programs.

2. Tap the Start button, tap All Programs, tap Recovery Manager, and then tap Recovery Media
Creation. If prompted, tap Yes to allow the program to continue.
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3. Tap Create recovery media using blank DVD(s), and then tap Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2).

To create a recovery USB flash drive:

1. Close all open programs.

2. Insert the USB flash drive into a USB port on the computer.

3. Tap the Start button, tap All Programs, tap Recovery Manager, and then tap Recovery Media
Creation.

4. Tap Create recovery media with a USB flash drive, and then tap Next.

5. Select the USB flash drive from the list of media. The program will let you know how much
storage is required to create the recovery drive. If the USB flash drive does not have enough
storage capacity (8 GB is the minimum), it will be grayed out on the screen. Tap Next.

NOTE: Recovery Media Creation formats the flash drive and deletes all on files on it.

6. Follow the on-screen instructions. Make sure to label the USB flash drive and store it in a secure
place.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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G Specifications

Table G-1  Specifications

Desktop Dimensions (in the desktop position)

Height

Width

Depth

3.95 in

13.3 in

14.9 in

10.0 cm

33.8 cm

37.8 cm

Approximate Weight 16.72 lb 7.6 kg

Weight Supported (maximum distributed load in desktop position) 77 lb 35 kg

Temperature Range

Operating

Nonoperating

50° to 95°F

-22° to 140°F

10° to 35°C

-30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options
installed.

Relative Humidity (noncondensing)

Operating

Nonoperating (38.7°C max wet bulb)

10-90%

5-95%

10-90%

5-95%

Maximum Altitude (unpressurized)

Operating

Nonoperating

10,000 ft

30,000 ft

3048 m

9144 m

Heat Dissipation

Max STD PS

Typical STD PS idle

Max EPA 87/89/85% @ 20/50/100% load PS

Typical EPA 87/89/85% @ 20/50/100% load PS idle

1063 BTU/hr

198 BTU/hr

941 BTU/hr

150 BTU/hr

268 kg-cal/hr

50 kg-cal/hr

237 kg-cal/hr

38 kg-cal/hr
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Table G-1  Specifications (continued)

Power Supply

Power Output

Rated Input Current (maximum)1

Rated Line Frequency

Operating Line Frequency Range

Max Allowable Leakage Current

Power Supply Fan

115V

240W

4A @ 100 VAC

50/60 Hz

47-63 Hz

275 µA

92mm variable speed

230V

240W

2A @ 230 VAC

50/60 Hz

47-63 Hz

275 µA

92mm variable speed

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark
requirements for use in the countries of the European Union. The active power factor corrected power supply also has the
added benefit of not requiring an input voltage range select switch.
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installing 46
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removal and replacement 73
spare part number 28, 35, 73

helpful hints 97

I
installing

drive cables 55
expansion card 46
hard drive 66
media card reader 63
memory 43
mounting screws 55
optical drive 59

Internet access problems 133

K
keyboard

cleaning 23
connector 3
spare part numbers 29, 30,

32, 33
keyboard problems 119

L
LEDs

blinking power 94
blinking PS/2 keyboard 94

line-in connector 3
line-out connector 3
locks

cable lock 86
front bezel 88
padlock 87

M
media card reader

installing 63
removing 61

Media Card Reader problems
108

memory
installing 43
populating sockets 44
specifications 43

memory module
spare part number 43

memory modules
spare part number 28, 35, 36

memory problems 126
microphone connector 2
monitor connector

DVI-D 3
VGA 3

monitor problems 110
mounting screws 55
mouse

cleaning 24
mouse connector 3
mouse problems 119
mouse, spare part number

spare part number 30, 33

N
network connector 3
network problems 123
numeric error codes 93

O
operating guidelines 22
optical drive

installing 59
removing 57
spare part number 35, 54
spare part numbers 29

optical drive problems 129
overheating, prevention 22

P
password

clearing 137
power-on 137
setup 137

PCI card 49
PCI Express card 50
POST error messages 92
power cord set requirements

country specific 91
power problems 103

power supply 149
fan 24
removal and replacement 78
spare part number 28, 33, 78

power switch/LED assembly
spare part number 28

power-on password 137
printer problems 117
problems

audio 115
CD-ROM or DVD 129
flash drive 131
front panel 132
general 99
hard drive 105
hardware installation 121
Internet access 133
keyboard 119
Media Card Reader 108
memory 126
monitor 110
mouse 119
network 123
power 103
printer 117
processor 128
software 136

processor
removal and replacement 76
spare part number 29

processor problems 128
product ID location 4, 37

R
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